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IMPORTANT SAFETY INSTRUCTIONS 
 

 

The lightning flash with arrowhead symbol within an equilateral triangle is 
intended to alert the user to the presence of uninsulated “Dangerous voltage” 
within the product’s enclosure that may be of sufficient magnitude to constitute 
a risk of electric shock to persons. 

 

The exclamation point within an equilateral triangle is intended to alert the user 
to the presence of important operating and maintenance (Servicing) instructions 
in the literature accompanying the product. 

 
• Read and keep these instructions 
• Heed all warnings. 
• Follow all instructions. 
• Do not use this apparatus near water 
• Clean only with dry cloth. 
• Do not block any ventilation openings.  Install in accordance with the manufacturer’s 

instructions. 
• Do not install near any heat sources such as radiators, heat registers, stoves, or other 

apparatus (including amplifiers) that produce heat. 
• Do not defeat the safety purpose of the polarized or grounding-type plug.  A polarized plug 

has two blades with one wider than the other.  A grounding-type plug has two blades and a 
third grounding prong.  The wide blade or the third prong is provided for your safety.  If the 
provided plug does not fit into your outlet, consult an electrician for replacement of the 
obsolete outlet. 

• Protect the power cord from being walked on or pinched particularly at plugs, convenience 
receptacles and the point where they exit from the apparatus. 

• Only use attachments/accessories specified by the manufacturer 
• Unplug this apparatus during lightning storms or when unused for long periods of time. 
• Refer all servicing to qualified service personnel.  Servicing is required when the apparatus 

has been damaged in any way, such as power-supply cord or plug is damaged, liquid has 
been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain 
or moisture, does not operate normally, or has been dropped. 

 

 

WARNING:  
TO REDUCE THE RISK OF FIRE OR ELECTRICAL SHOCK, DO NOT EXPOSE 
THIS EQUIPMENT TO RAIN OR MOISTURE. DO NOT EXPOSE THIS 
EQUIPMENT TO DRIPPING OR SPLASHING AND ENSURE THAT NO 
OBJECTS FILLED WITH LIQUIDS ARE PLACED ON THE EQUIPMENT 

 

 

WARNING:  
THIS EQUIPMENT USES POWER/MAINS CONNECTORS FITTED WITH 
SAFETY GROUND PINS. TO REDUCE THE RISK OF ELECTRIC SHOCK, 
GROUNDING OF THE GROUND PIN OF THE MAINS PLUG MUST BE 
MAINTAINED.  IN ADDITION GROUNDING OF GROUND TERMINAL ON THE 
MAIN EQUIPMENT CHASSIS MUST BE MAINTAINED. 



   

 

 

WARNING:  
DANGEROUSLY HIGH VOLTAGES ARE PRESENT INSIDE THE POWER 
SUPPLY FRAME. 

 

 

WARNING:  
TO COMPLETELY DISCONNECT THIS EQUIPMENT FROM THE AC MAINS, 
DISCONNECT THE POWER SUPPLY CORD PLUG FROM THE AC 
RECEPTACLE THIS EQUIPMENT MAY HAVE MORE THAN ONE POWER 
SUPPLY CORD. TO REDUCE THE RISK OF ELECTRIC SHOCK, DISCONNECT 
ALL POWER SUPPLY CORDS BEFORE SERVICING. 

 
CAUTION: These servicing instructions are for use by qualified personnel only. To reduce the risk of 
electric shock, do not perform any servicing other than that contained in the operating instructions unless 
you are qualified to do so. Refer all servicing to qualified personnel. 
 
CAUTION: To reduce the risk of electric shock, plug each power supply cord into separate branch circuits 
employing separate service grounds. 
 
NEVER use flammable or combustible chemicals for cleaning components. 
NEVER operate this product with any covers removed. 
NEVER wet the inside of this product with any liquid. 
NEVER bypass any fuse or replace any fuse with a value or type other than those specified. 
NEVER operate this product in an explosive atmosphere. 
NEVER block the airflow through ventilation slots. 
NEVER expose this product to extremely low or high temperatures. 
 
This product complies with the requirements of the product family standards for video, audio, audio-visual 
entertainment, and lighting control apparatus for professional use as mentioned below. 
 

 



  

INFORMATION TO USERS IN EUROPE 
NOTE 

 
This equipment with the CE marking complies with both the EMC Directive (89/336/EEC) and the Low Voltage 
Directive (73/23/EEC) issued by the Commission of the European Community. 
 
Compliance with these directives implies conformity to the following European standards: 

• EN60065 Product Safety 
• EN55103-1 Electromagnetic Interference Class A (Emission) 
• EN55103-2 Electromagnetic Susceptibility (Immunity) 

 
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to the 
European Union EMC directive.  These limits are designed to provide reasonable protection against harmful 
interference when the equipment is operated in a commercial environment.  This equipment generates, uses, and 
can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may 
cause harmful interference to radio communications.  Operation of this equipment in a residential area is likely to 
cause harmful interference in which case the user will be required to correct the interference at his own expense. 

 

 
 

EN60065 Safety   
EN504192 2005 

Waste electrical products should not be 
disposed of with household waste. Contact 

your Local Authority for recycling advice 

EN55103-1: 1996 Emission 
EN55103-2: 1996 Immunity 



   

INFORMATION TO USERS IN THE U.S.A. 
NOTE 

 
FCC CLASS A DIGITAL DEVICE OR PERIPHERAL 

 
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of 
the FCC Rules.  These limits are designed to provide reasonable protection against harmful interference when the 
equipment is operated in a commercial environment.  This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful 
interference to radio communications.  Operation of this equipment in a residential area is likely to cause harmful 
interference in which case the user will be required to correct the interference at his own expense. 
 

WARNING 
 

Changes or Modifications not expressly approved by Evertz Microsystems Ltd. could void the user’s authority to 
operate the equipment. 
 

Use of unshielded plugs or cables may cause radiation interference.  Properly shielded interface cables with the 
shield connected to the chassis ground of the device is a must.

Evertz Microsystems Ltd This device complies with part 15 of the FCC Rules. Operation 
is subject to the following two conditions: 
 
This device may cause harmful interference, and this device 
must accept any interference received, including interference 
that may cause undesired operation. 

 

 
Tested to comply 
with FCC 
Standards 

For Home or Office Use 
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Information contained in this manual is believed to be accurate and reliable. However, Evertz assumes no responsibility for the use thereof 
nor for the rights of third parties, which may be affected in any way by the use thereof.  Any representations in this document concerning 
performance of Evertz products are for informational use only and are not warranties of future performance, either expressed or implied. The 
only warranty offered by Evertz in relation to this product is the Evertz standard limited warranty, stated in the sales contract or order 
confirmation form. 
 
Although every attempt has been made to accurately describe the features, installation and operation of this product in this manual, no 
warranty is granted nor liability assumed in relation to any errors or omissions unless specifically undertaken in the Evertz sales contract or 
order confirmation.  Information contained in this manual is periodically updated and changes will be incorporated into subsequent editions.  If 
you encounter an error, please notify Evertz Customer Service department. Evertz reserves the right, without notice or liability, to make 
changes in equipment design or specifications. 
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1. OVERVIEW 

The 7800DA8-12G is a 1x8 distribution amplifier for a wide range of signal rates, including the most 
current 12G standard. Inputs are automatically equalized and eight isolated, re-clocked outputs are 
provided. Full remote monitoring and control of important parameters is provided with 
SNMP/VistaLINK. 
 
 
Features & Benefits 
 
 Automatic input equalization 

 Automatic Reclocking 

 VistaLINK® capable for remote monitoring, control and configuration capabilities via SNMP 
using VistaLINK® PRO, CP-2116E or CP-2232E Control Panels. VistaLINK® is available when 
modules are used with the 7800FR or 7801FR with 7800/7801FC frame controller installed.  

 
 
Standards Supported 

 
• SMPTE ST 2082/1 

• SMPTE ST 424M 

• SMPTE ST 344M 

• SMPTE ST 292M 

• SMPTE ST 259M 
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Figure  1-1 : 7800DA8-12G Block Diagram 

 
Ordering Information 
 
7800DA8-12G  12G/3G/HD/SD 1X8 Reclocking Distribution Amplifier 
 
 
Rear Plate Suffix 
+3RU   3RU Rear Plate 

 
Enclosures 
7800FR  3RU Multiframe which holds up to 15 single slot modules 

7800FR-QT  3RU Multiframe which holds up to 15 single slot modules, low noise 

7801FR  1RU Multiframe which holds up to 4 single slot modules or two dual slot modules 
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2. INSTALLATION 

The 7800DA8-12G comes with a companion rear plate that occupies one slot in the frame. For 
information on inserting the module into the frame see section 3 of the 7800FR manual. 
 

 

Figure  2-1 : 7800DA8-12G Rear Panel 
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IN: Input BNC connector for 10-bit serial digital video signals compatible with the 

SMPTE 424M, SMPTE 292M, and SMPTE 259M standard.  See section  5.2 for 
information on selecting the correct video standard. 

 
OUT: There are eight BNC connectors with reclocked serial component video 

outputs, compatible with the SMPTE 424M, SMPTE 292M, and SMPTE 259M 
and non reclocked SMPTE 344M (540Mb/s), and SMPTE 259 (360Mb/s, 
143Mb/s). 
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3. SPECIFICATIONS 

3.1 SERIAL VIDEO INPUT 

Standards 
Reclocked Mode: SMPTE 2082 (12Gb/s) 

 SMPTE 424M (3Gb/s) 

 SMPTE 292M (1.5Gbs) 

 SMPTE 259M (270Mb/s) 

 

Non reclocked Mode: SMPTE 344M (540Mb/s)  

 SMPTE 259M (360Mb/s, 143 Mb/s) 

Connector:  BNC per IEC 61169-8 Annex A 

 
Equalization  Automatic to 80m @ 3Gb/s, 140m @ 1.5Gb/s & 350m @ 270 Mb/s 

Return Loss > 15dB up to 1.5Gb/s 

 > 10dB up to 3Gb/s 

 

3.2 SERIAL VIDEO OUTPUTS 

Number of Outputs 8 Reclocked 

Connector  BNC per IEC 61169-8 Annex A 

Signal Level 800mV nominal 

DC Offset: 0V ±0.5V 

Rise and Fall Time 150ps @ 3g/HD, 470ps SD 

Wide Band Jitter: < 0.2 UI 

 

3.3 ELECTRICAL 

Voltage +12V DC 

Power 5 Watts 

EMI/RFI Complies with FCC Part 15, Class A devices 

 Complies with EU EMC Directive 
 

3.4 PHYSICAL 

Number of slots   1 
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4. STATUS LEDS 

The 7800DA8-12G has six LED Status indicators on the front card edge to show operational status of 
the card at a glance. Figure  5-1 shows the location of the LEDs. 
 
Two large LEDs on the front of the board indicate the general health of the module. 
 
 
LOCAL FAULT: This Red LED indicates poor module health and will be On during the absence 

of a valid input signal or if a local input power fault exists (i.e. a blown fuse). The 
LOCAL FAULT indication can also be reported to the frame through the FRAME 
STATUS jumper.  

 
REMOTE:  This LED will come On when the Control jumper J19 is installed in the Remote 

position.  
 
MODULE OK: This Green LED indicates good module health. It will be On when a valid input 

signal is present, and board power is good. 
 
RECLOCKER RATE: There are 3 LEDs that indicate the rate (143, 270Mb/s, and 1.5Gb/s) that the 

reclocker is currently using when the Rate jumper is set to the 259M/344M 
position. 
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5. JUMPERS AND USER ADJUSTMENTS 

 

Figure  5-1 : LED and Jumper Locations 
 

5.1 SELECTING WHETHER LOCAL FAULTS WILL BE MONITORED BY THE GLOBAL FRAME 
STATUS 

The FRAME STATUS jumper J1, located at the front of the module, determines whether local faults 
(as shown by the Local Fault indicator) will be connected to the 7700FR frame's global status bus. 
 
FRAME STATUS: To monitor faults on this module with the frame status indicators (on the power 

supply’s FRAME STATUS LED's and on the Frame's Fault Tally output) install 
this jumper in the On position. 

 
 When this jumper is installed in the Off position local faults on this module will 

not be monitored. 
 
5.2 SELECTING WHETHER MODULE WILL BE CONTROLLED FROM THE LOCAL CONTROLS 

OR THROUGH THE VISTALINK® INTERFACE 

The CONTROL jumper J2 selects whether the module will be controlled from the local jumpers or 
through the VistaLINK® interface. 
 
CONTROL: When this jumper is installed in the LOCAL position, the card functions are 

controlled through the local jumpers. 
 
 When this jumper is installed in the REMOTE position, the card functions are 

controlled through the VistaLINK® interface.  
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5.3 SELECTING THE RECLOCKING RATE 

The RCLK jumper J7, located at the front of the module near the card ejector, determines whether the 
module will operate as a re-clocking distribution amplifier with SMPTE 292M, SMPTE 259M or 344M 
(143 to 540 Mb/s) or with SMPTE 310M (19.4 Mb/s) signals. 
 
RATE SELECT:  Auto: Re-clocking mode is set to auto based on sensed input signal. 

Bypass: Re-clocking mode is bypassed. 
 
5.4 CONFIGURING THE MODULE FOR FIRMWARE UPGRADES 

UPGRADE: The UPGRADE jumper J4 located at the front of the module near the card 
ejector, is used when firmware upgrades are being done to the module.  For 
normal operation it should be installed in the RUN position. See the Upgrading 
Firmware section in the front of the binder for more information. 

 
 To upgrade the firmware in the module unit pull it out of the frame.  Move 

Jumper J4 into the UPGRADE position and then install the Upgrade cable 
provided (located in the vinyl pouch in the front of this manual) onto header J3.  
Then the module should be re-installed into the frame.  Run the upgrade as 
described in the Upgrading Firmware section in the front of the binder.  Once the 
upgrade is complete, remove the module from the frame, move J4 to the RUN 
position, remove the upgrade cable and re-install the module.  The module is 
now ready for normal operation. 
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6. VISTALINK REMOTE CONTROL/MONITORING 

This chapter assumes that the VistaLINK® PRO server and client are already configured for your 
network and you have basic knowledge of the VistaLINK® PRO interface. It also assumes that the user 
or network administrator has already added the appropriate jar file to the server, and both the client 
and server applications have been restarted.  If you are the network administrator, refer to section  7  
for information on updating the VistaLINK® PRO Server Jar File. 
 
Open VistaLINK® PRO and click on the refresh tree icon. Expand the hardware tree by clicking on the 
“+” button. Your card should appear as a newly listed device under the IP address of the frame 
controller for the frame that the 7800DA8-12G is installed in. 
 
Consult the network administrator if there is any problem connecting the card with VistaLINK® PRO; 
alternatively contact Evertz Microsystems Ltd. or the authorized reseller for technical support. 
 
 

 
NOTE: When using VistaLINK® PRO it is important to ensure that the most recent 
7800DA8-12G “.JAR” control file is installed.   

 
 

6.1 VISTALINK® PRO INTERFACE 

The 7800DA8 series products are controlled using VistaLINK® PRO. VistaLINK® PRO operates using 
Ethernet and SNMP control protocols. The 7800DA8 series modules do not have card edge controls. 
As a result, frame controller modules must be installed in all frames that house 7800DA8 modules. 
 
Within VistaLINK® PRO the 7800DA8 series modules have system configuration controls which can be 
accessed by right-clicking on the module in the VistaLINK® PRO hardware tree, and selecting “View 
Configuration…”.  
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Figure  6-1 : VistaLINK® PRO – View Configuration 

 
By selecting View configuration, the configuration page will be opened (Figure  6-2). 
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Figure  6-2 : VistaLINK® PRO – 7800DA8-12G Configuration 

 
Video Control 
 
Video Present Status: This parameter indicates if the video is present or not. 

Video Mode Status: This parameter indicates video mode status of the card. 

 
Output Channel Control 
 
For Channel 1-8:  
This section allows the user to select output channels. 
 
Video Traps 
 
The Fault control allows the user to enable or disable traps and view trap status. To enable a particular 
trap, simply click the box located beside each trap, so that check-mark appears. When a check-mark is 
present, the trap is enabled.  
The Fault Status displays whether a fault is active or not. If the box is green then the corresponding 
trap is not active. 
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7. UPGRADE PROCEDURES 

7.1 UPGRADE FIRMWARE 

A firmware upgrade can be accomplished through VistaLINK® PRO firmware upgrade facilities. All 
7800DA8-12G modules within the same 7700FR/7800FR frame can be upgraded simultaneously or  
one-by-one.  However, it is more convenient to upgrade them simultaneously. 
 
Right click on 7700FR/7800FR frame that contains the 7800DA8 modules, and select Version 
Information. 
 

 
Figure  7-1 : VistaLINK® PRO - Version information selection 
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Navigate the hardware tree on the left side of the version information window to select the  
7800DA8-12G module listed. The list on the right side of the window should populate with all  
7800DA8-12G modules present in the 7700FR/7800FR.Take note of the current firmware version 
installed on the 7800DA8-12G modules to confirm afterwards that the upgrade has completed 
successfully. 
 

 
Figure  7-2 : VistaLINK® PRO - Version Information Window 

 
Check the Upgrade checkbox for all modules that require the firmware upgrade. Press Upgrade button.  
This will open a new Upgrade Firmware window. Press the Browse button to navigate to the firmware 
archive provided for upgrading the 7800DA8-12G modules (File extension is .bin). Once the correct 
file has been selected, press the Start button to begin the upgrade process. 
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Figure  7-3 : VistaLINK® PRO - Upgrade Firmware Window 

 
After the firmware has been transmitted to the 7800DA8-12G module successfully, the module will 
reboot to complete the firmware upgrade process. Close the Upgrade Firmware window and  
Version Information window. 
Once the cards have rebooted, ensure all 7800DA8-12G modules are still present in the VistaLINK® 
PRO hardware tree. Right click on 7700FR/7800FR frame that contains the 7800DA8-12G modules 
and select Version Information. Navigate the hardware tree on the left side of the version information 
window to select the 7800DA8-12G module listed. The list on the right side of the window should 
populate with all 7800DA8-12G modules present in the 7700FR/7800FR. 
 

 
NOTE: If any of the 7800DA8-12G modules do not properly upgrade the firmware, please 
power-cycle those boards and retry the procedure exclusively on the failed boards.  If the 
issue still persists, contact Evertz for further assistance. 

 
 

7.2 UPDATING VLPRO SERVER JAR FILE 

Products from Evertz are constantly evolving and new features are often added. It is therefore 
important to update the JAR files in use to provide access to all the latest features or enhancement. It 
is also necessary to add JAR files for new products. 
 
To perform a JAR update, ensure that all VLPro clients are closed (those clients which are not closed 
will automatically be disconnected as soon as the VLPro server is restarted).  
 
Select Help>Apply Update>Product from the menu. 
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Figure  7-4 : VistaLINK® PRO Server - Apply Update 

 
A window will appear as is shown in Figure 7-5. Navigate to the location of the new JAR file and double 
click to select the file. The window will automatically close and the update will be applied in the 
background. 
 

 
Figure  7-5 : VistaLINK® PRO Server – Applying JAR Updates 
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The user will be prompted to restart the server to enable the change to take effect. Apply as many JAR 
updates as required before restarting the server. 

 

 
NOTE: It can be confirmed that all updates have been successfully applied by selecting 
from the menu Tools>View>Show/Hide Product update log. 

 
 
Shutdown the server by selecting from the menu: File>Shutdown Server. Now re-open the server, it is 
normal for the start up to take marginally longer while each individual update is being applied. Once 
complete, you may restart the VLPro Clients. As the Client restarts, a short delay may happen while 
the update is applied. A prompt will appear confirming that the updates have been applied. 
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